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Import Tool for PanelBuilder
InduSoft introduces the Import Tool for PanelBuilder™ — a powerful, flexible, easy-to-use tool that expands
the capabilities of your installed plant-floor systems. The Import Tool is a fast and intuitive wizard for
importing applications created with PanelBuilder™ (Allen-Bradley's programmer for PanelView™ HMIs) into
InduSoft Web Studio.

Using the Import Tool to import PanelBuilder applications into IWS
After importing an application into InduSoft Web Studio features:
•

Flexibility: IWS can run the project on any Microsoft® Windows® platform (Windows XP/Vista/7 or
Windows Embedded). For example, you can run the project on devices powered with Windows Embedded,
such as HMI panels and PDAs (iPAQ, Toshiba, Dell, etc.).

•

Expansibility: You can use the IWS development environment to add functionality to your project in the
form of historical data, XML reports, math scripts, etc.

•

Connectivity: Because the project is running under the IWS runtime, you can take advantage of all
connectivity tools embedded in the IWS package, such as:
•

Communication drivers for several protocols from different manufacturers (Modbus, Profibus DP,
DeviceNET, ControlNET, Siemens S7 - MPI/PPI, Siemens S5 - RK512, GE-Fanuc SNP/SRTP and many
others).

•

OPC client and server interfaces.

•

XML and ADO interfaces to exchange data with third-party systems, such as Enterprise Resource
Planning (ERP) systems.

•

API Toolkits to integrate the project with third-party programs written in any language that supports
DLLs (VB, C, C++, and so on).

•

TCP/IP modules for redundant and networked projects.

•

Web solution that provides remote access to your project using just a web browser, through any TCP/IP
link (intranet, internet, or dial-up connection).

•

Remote management and debugging tools that allow you to manage (download, upload, run, stop and
debug) your project remotely from a development station.

The Import Tool's greatest advantage is how easy it is to use, which can dramatically reduce the cost and
hassle of modernizing the automation systems in your facility.
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Importing a PanelBuilder application
The procedure to import a PanelBuilder application into your IWS project consists of three general steps.
To import a PanelBuilder application, you must have the following software on your computer:
•

PanelBuilder programming software.

•

PanelBuilder application file (*.pba).

•

InduSoft Web Studio with the Import Tool for PanelBuilder add-on.
Note: You can run the InduSoft Web Studio development environment on Windows XP/Vista/7
operating systems. For detailed information about IWS hardware and software requirements, see the
IWSUser Guide and Technical Reference.

1. Add a Generic / Text Only printer to your computer. This allows you to "print" to a raw text file.
2. Generate a report file for the PanelBuilder application that you want to import.
3. Use the Import Tool for PanelBuilder to import the report file into IWS.
These general steps are explained in detail in the following sections.

Adding a Generic / Text Only printer
This section explains how to add a Generic / Text Only printer to your computer, so that you can "print" to
raw text files.
1. Click the Windows Start button, and then on the Start menu, click Devices and Printers.
The Devices and Printers control panel is displayed.
2. Click Add a printer.
The Add Printer wizard is displayed.
3. Click Add a local printer.

Adding a local printer
The next step of the wizard is displayed.
4. Select Use an existing port, and then in the list of available ports, click FILE.

Choosing a printer port
5. Click Next.
The next step of the wizard is displayed.
6. In the Manufacturer list, click Generic, and then in the Printers list, click Generic / Text Only.

Selecting the Generic / Text Only printer
7. Click Next.
The next step of the wizard is displayed.
8. Leave the default printer name, and then click Next.

Specifying the printer name
The next step of the wizard is displayed.
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9. Select Do not share this printer, and then click Next.

Do not share the printer
The next step of the wizard is displayed.
10.Clear the Set as the default printer option, and then click Finish.

Do not set it as the default printer
The printer is added to the Devices and Printers control panel.

Generating a PanelBuilder application report
This section explains how to generate a PanelBuilder application report that can be imported into InduSoft
Web Studio.
1. Start the PanelBuilder programming software, and then open the application for which you want to
generate a report.
2. On the Tools menu, click Options.
The Options dialog is displayed.
3. Click the Report Setup tab.
4. Select all of the options listed in the Application area, and then click OK.

Setting up the application report
5. On the File menu, click Reports.
The Print Reports dialog is displayed.
6. Click Printer Setup.
The Printer Setup dialog is displayed.
7. In the Printer area, click the Name combo-box and then select Generic / Text Only from the list.

Selecting the printer
8. In the Paper area, click the Size combo-box and then select A3 from the list.

Selecting the paper size
9. In the Orientation area, select Landscape.

Selecting the orientation
10.Click OK to return to the Print Reports dialog.

Print Reports dialog
11.In the Include area, clear the Screen Images option.

Clearing the Screen Images option
12.Click Print.
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The Print to File dialog is displayed.
13.In the Output File Name box, type the full path and name of the report file, and then click OK.

Specifying the output file name
PanelBuilder will save the application report file to the designated location. Now you can import this file into
InduSoft Web Studio.

Using the Import Tool for PanelBuilder
The Import Tool provides a simple, straightforward wizard to guide you through the process of importing
PanelBuilder applications into your IWS project.
1. In the IWS development environment, close all open project screens and worksheets.
2. On the Home tab of the ribbon, in the Tools group, click Import Wizard.
The Import Wizard dialog is displayed.
3. In the Source Type list, select Import Tool for PanelBuilder™, and then click Next.
Note: You can use the Import Wizard to import application data from sources other than
PanelBuilder applications. For more information about importing other application types, refer to
the IWS User Guide and Technical Reference.
The Import Tool for PanelBuilder™ Wizard dialog is displayed.

Specifying import parameters in the Import Tool dialog
4. Use the dialog to specify the import parameters.
a) Do not import duplicate tags: Select this option to prevent the Import Tool from importing tags with the same
name as tags in the current IWS project database.
b) Replace duplicates with tags imported: Select this option if you want the wizard to replace duplicate tag
properties in the current IWS project database.
c) Import Screens: This option is selected by default. Clear this option to prevent the Import Tool from
importing the PanelBuilder application screens.
d) Import Comm. Configruation: This option is selected by default. Clear this option to prevent the Import Tool
from importing the communication properties configured for each tag in the PanelBuilder application.
e) Report File: This field displays the path and name of the folder where the PanelBuilder application report
file is saved. To select a different file, click Browse.
f) Use prefix: Select this option if you want to add a prefix to all imported tags, and then type the prefix in
the text field.
Because you can import multiple PanelBuilder applications into a single IWS project, this option is
provided to help you identify where the imported application tags originated and to avoid duplications.
5. Click Next.
The Import Tool will read the database and then display a new dialog that lists all of the tags in the
selected PanelBuilder application.
6. Review the list of tags and uncheck any that should not be imported.
The tags are color-coded:
•

Red tags cannot be imported. If you selected the Do not import duplicate tags option, then the Import Tool
will not import tags that already exist in your IWS project database.

•

Blue tags will be imported. If you do not want to import one of these tags, clear the check-box to the left
of the tag name.

•

Gray tags can be imported but are not currently selected. Tags become gray in two circumstances:
•

You cleared the check-box to the left of an importable (blue) tag, which changes the blue tag to gray.
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•

You have exceeded the number of tags allowed by your InduSoft Web Studio license. For example, if
your license allows 1,500 tags and you would exceed this limit by importing the grey tags, then IWS
will not allow the wizard to add these tags to the project database.

You can import gray tags (by clicking the check-box to the left of the tag name), as long as you do not
exceed the number of tags allowed by your license.
7. Click Finish.
The PanelBuilder application is imported into your IWS project, according to the specified parameters.
If your application uses bitmaps (*.bmp) other than those in the standard PanelBuilder list, export the bitmap
files from PanelBuilder and then copy them to:
Lib
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What is imported by the Import Tool for PanelBuilder
The Import Tool for PanelBuilder is still going through the development process. This first release implements
the most important features. The following sections describe all of the features that are not imported
automatically. Because both InduSoft Web Studio and CEView are much more powerful than PanelBuilder,
it is possible to work around the items that are not imported by implementing some minor changes in the
project. If, however, your project uses one of the features that the import wizard does not import, and you
think that you will spend a lot of time implementing this feature in your project, please contact your InduSoft
representative or go to www.indusoft.com. We will analyze the feasibility of implementing that specific feature.

Graphical Interface
The graphical tools offered by InduSoft Web Studio overcome the expectations when compared with the other
tools available in the market. When importing the application using the Import Tool, you will realize that the
imported graphical interface will look even better than the original one. However, some features available
in other products are very different from the way that IWS implements them. The InduSoft development
philosophy is to implement Windows standards and use simple-to-use controls, making the product easy to
use. You can develop good looking screens in a few minutes. During our development research we realized
that some features available in the PanelBuilder are so "unusual" that most of the applications do not use
them. These features are not being imported, because most of the applications that we tested against did not
use them. The following properties, unless they are explicitly declared in the graphical compatibility list (see
next topic), are not imported by the Import Tool: Shape, Fill Pattern, Graphic, Line Type and Print.
The following table has all the objects supported by PanelBuilder and the properties not supported by the
Import Tool. Properties described as "Not supported1" are features that we found in some of the applications
that we tested against and will probably be implemented for future releases. Properties described as "Not
supported2" are minor items that do not enhance the graphical interface and will not be implemented unless
there is a strong reason to do so. If there is any property associated with an object that you could not find
in this list, it means that the property is not being imported and that you should contact your InduSoft
representative with the information about the specific property, or go to www.indusoft.com.
PanelBuilder

IWS

Original Object

Converted Object

Pushbutton – Momentary,
Maintained, and Latched

Pushbutton

Screen Selector – Goto

Button + Command (Open
Screen)

Property

Comment

Write Tag

Tag / Expression

Hold Time

Not supported

Indicator/Display Tag

Indicator

Handshake Tag

Reset

Data Type/Format

Not supported

Contact Type

State

Initial State

Not supported

States

•

Number: <0 - Open / 1 - Closed / Error - Additional Pushbutton
with Position>

•

Graphic: Not supported

•

Blink: Blink set to slow

•

Value: Value

•

FG Color: Not supported

•

BG Color: Color

•

Text Properties: All the properties are supported, but they
need to be the same for all the states.

1

2

1

2

1

Text properties

All text properties are supported.

FG Color

Not supported

BG Color

Button – Fill Color

InduSoft Web Studio
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PanelBuilder

IWS

Original Object

Converted Object

Screen Selector – Return

Button + Command (Open
Previous)

Not supported

Screen Selector – Screen List
Selector

List Box, Button + Command
(Open Screen)

Numeric Entry – Keypad Enable

Rectangle + Command, Text +
Text/Data Link

Rectangle + Command,
Rectangle with caption

Numeric Entry – Inc/Dec

Not supported

Control List Selector (Standard
and Piloted), Indicator – List

List Box

Comment

Destination

Parameter passed to Open Screen function of the Command
animation.

Text properties

All text properties are supported.

FG Color

Not supported

BG Color

Button – Fill Color

Blink

Position animation applied to Button object.

Wrap List

List Box – List Wrap option

FG Color

List Box – Border Color

BG Color

List Box – Fill Color

Fix Cursor At State

Not supported

Text properties

Wrap is the only text property not supported. The font size and
background color will be the same for all the items in the screen list.

Text properties

Text/Data Link properties

FG Color

Rectangle – Line Color

BG Color

Rectangle – Fill Color

Write Tag

Text/Data Link – Tag / Expression, Command – Keypad function

Indicator/Display Tag

Not supported

2

Notification Tag

Not supported

1

Handshake Tag

Not supported

1

Decimal Point

Format function in the tag / expression

Blink

Position animation applied to object

Text properties

Rectangle caption properties

FG Color

Rectangle – Line Color

BG Color

Rectangle – Fill Color

Write Tag

Used in the Command animation that activates the keypad

Indicator/Display Tag

Used in the Rectangle caption

Notification Tag

Not supported

1

Handshake Tag

Not supported

1

Decimal Point

Format function in the Rectangle caption

Write Tag

Write Tag

Search Tag or Read Tag

Read/Search Tag

Control Tag

Control Enable

Block Write Start Tag

Not supported

Data Type/Format

Integer value, LSB and Single Bit modes are supported

Initial State

Not supported

Write Value On Enter

Enter Reqd

2

1

Screen Selector – Goto Config
Screen

Numeric Entry – Cursor Point

Property

1

1
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PanelBuilder

IWS

Original Object

Converted Object

Graphic Indicator – Bar Graph

Rectangle + Bargraph,
Rectangle with caption

Not supported

Graphic Indicator – Scale Linear

Set of Line objects representing
the scale

Not supported

Numeric Data Display

Rectangle

Indicator – Message Display
and Multistate Pushbutton

Graphics – Line

Wrap List

List Wrap

FG Color

Border Color

BG Color

Fill Color

States

•

Number: List Box State number or Error State

•

Message: List Box message

•

Access: Not supported

•

Value: Value

•

Text Properties: Alignment option is not supported. Text
Foreground Color, Font and Size need to be the same for all
the states.

1

Text properties

Rectangle caption properties

FG Color

Rectangle – Line Color

BG Color

Rectangle – Fill Color

Read Tag

Bargraph – Expression

Fill

Bargraph – Foreground Color

Blink

Color animation applied to object

Fill From

Bargraph – Direction and Orientation properties

Min/Max Range

Bargraph – Min and Max properties

Blink

Position animation with Blink Slow applied to each Line object

FG Color

Color of each Line object

Tickmarks

Import Tool creates a line per each tick

Text properties

Rectangle caption properties

Read Tag

Used in the caption text between curly brackets ({})

Read Tag

Read Tag

Graphic

Not supported

Blink

Rec Blink

Value

Value

FG Color

Rec (FG)

BG Color

Rec (BG)

Graphic

Graphic File

Text properties

All properties are supported, but the Text Font and Size need to be
the same for all states.

Blink

Position animation applied to Line

FG Color

Color

1

Smart Message

Line

Comment

1

Graphic Indicator – Gauge

Graphic Indicator – Scale
Circular

Property

2

Note: There is no way to determine the direction of the line based on the report
information, so the Import Tool will always import the lines from down to up, left to right.
In some cases, you will need to flip the lines after finishing the import.
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PanelBuilder

IWS

Original Object

Converted Object

Graphics – Connected Line and
Free Form

Not supported

Graphics – Rectangle, Ellipse,
Circle

Rectangle, Ellipse

Graphics – Graphic Image

Linked Picture

Text

Not supported

Alarm List and Alarm Buttons

Alarm Control

Comment

FG Color

Line Color

BG Color

Fill Color

FG Color

Used to change the image color when importing

BG Color

Used to change the image color when importing

Text properties

Rectangle caption properties

Variables

All variables are inserted in the caption using the Format function,
when formatting is necessary.

1

Rectangle with caption

List Keys

Property

1

Alarm Control object inserted on screen, but its properties are not configured automatically. Alarm
Buttons are not imported, but can be added later.

Communication Interface
This release implements the most important communication drivers. However, some of the imported drivers
have some differences due the way that InduSoft Web Studio treats the information. Most of the applications
should not be affected by the differences, but in some cases small changes will be necessary. The following
table lists all the drivers supported by the Import Tool and describes the limitations of each one.
PanelBuilder

IWS

Protocol

Driver Name

Modbus Serial

MODBU

DH+ / DH485

ABKE, ABTCP, ABENI

Limitations, Restrictions, and Remarks

•

Signed and Unsigned variables will be imported as signed.

•

BCD Data Type is not supported.

•

Char Array data types are not supported.

•

Bit Arrays can only be used for readings.

DF1 Serial

In order to communicate using DH+ or DH485, you will need to acquire a specific board for
these protocols. Please refer to the ABKE driver documentation for more information about the
hardware needed.

DF1 Ethernet

•

Signed and Unsigned variables will be imported as signed.

•

Double words are not supported.

•

You cannot have PLCs from different families in the same network.

•

Bit Arrays can only be used for readings.

•

Bit Arrays for counters and timers are not allowed.
Note: These drivers were tested against the following devices: PLC5, Slick
PLCs, Micrologix PLCs and Micrologix 1761-NET-ENI. According to the
manufacturer documentation, the drivers should work with other devices. If you
cannot establish communication with your device, please contact your InduSoft
representative.

EthernetIP and ControlNet
(ControlLogix)

ABCIP

The Import Tool does not support the ControlNet network. When the ControlNet network is
identified, the Import Tool will convert all the tags using the ABCIP driver for Ethernet.
•

Network path is not supported.
Note: This driver was tested against the following devices: ControlLogix5000
and FlexLogix 1761-NET-ENI. According to the manufacturer's documentation,
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PanelBuilder

IWS

Protocol

Driver Name

Limitations, Restrictions, and Remarks
the driver should work with other devices. If you have a problem establishing
communication with your device, please contact your InduSoft representative.

Note: Driver configuration can be imported only once into an IWS project. If you change the
communication settings of a PanelBuilder application and try to import it again over a previously
imported application, the new settings will not be imported. You have to create a new blank IWS
project and import the modified PanelBuilder application into it.

Alarms Configuration
InduSoft Web Studio is very powerful and manages the entire alarm system without any additional PLC
programming. PanelBuilder, however, requires the alarms to be configured in the PLC and is only able to
display the alarm messages and provide the acknowledgment feature. Using the PanelBuilder philosophy and
migrating the whole PanelBuilder system to your IWS project would make applications as complex as they are
in PanelBuilder. The Import Tool has adopted a different approach by importing the information necessary
to turn on the IWS alarm system and displaying all the alarm messages with Acknowledge capabilities.
Depending on the PanelBuilder features that you are using on your application, you will have to perform some
minor configurations in your imported application. Read the following topics to understand how the Alarm
Configuration is imported and which features are not imported automatically.

Alarm Banner
Instead of importing the PanelBuilder alarm banner, the Import Tool creates an alarm banner screen with
the powerful Alarm Control object and all the corresponding alarm buttons. You can eliminate some of the
buttons if necessary. The alarm banner has also a default size (the size is not imported). If the object size is
not appropriate for your application, you can open the Alarm_Banner screen in the development environment
and customize it.

Alarm Setup
Banner Pop Up: Implemented automatically by Import Tool by selecting the alarm banner as Pop Up or
Dialog.
Print Items: IWS will print the alarms in the way that they are formated in the alarm object. You can
customize the columns as well as the order in which the alarms will be printed. This powerful capability
is imported in the alarm object that is inserted in your screen and can be customized. Because of this
functionality we ignore the print items parameter.
Ack Hold Time and Snapshot: IWS's Alarm Control object is a scroll list with many capabilities. These
parameters are also not applied.
Remote Ack and Use Optional Fields: IWS supports remote acknowledgment by alarm message and alarm
group. PanelBuilder works very differently and in some cases the user is required to associate bits of tags to
acknowledge alarms. If you are using this functinality you will have to implement some minor scripts using a
Math or Script worksheet. This parameter is ignored.

Alarm Triggers
Trigger Tag: Tag used as a base to generate the alarm messages inside the imported project.
Trigger Type: The Import Tool supports Bit and Value triggers.
Ack, Remote and Handshake and Ack All: When importing the alarm list, the Import Tool creates an Alarm
worksheet with all the alarm messages. In order to implement this command, you will need to implement
some additional configuration in the worksheet.

Alarm Messages
The Alarm Messages are implemented using auxiliary tags. The names of the auxiliary tags are formed using
the formula [Trigger Tag]_Alr_[Value], where:
•

[Trigger Tag] is the name of the tag used as trigger; and
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•

[Value] is the value specified in the value column.

The auxiliary tags will have the alarm HI configured to 1 (one) with the PanelBuilder alarm message. If the
trigger is a Bit, the tag will be associated with the specific bit in the Driver worksheet, otherwise it will be
in a Scheduler worksheet and will go off when the trigger value assumes the value specified in the value
column. All the parameters available in the Alarm Messages configuration are available in IWS, but because
the concept is completely different (PanelBuilder requires that the user configures colors per individual alarms
instead of configuring per groups), they are not automatically imported.

Security System
The current version of the Import Tool does not import the security system automatically. After importing the
application, you can reconfigure the security system manually, using the Security System editor.
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